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What is a tag?
A tag is a textual label which you associate to a physical file, the idea is that you search on these tags in 
order to find your files rather than manually navigating through the traditional directory hierarchy on your 
hard disk using the file explorer.

Any number of tags can be attached to a file making searching far more powerful. Prior to using tags, a 
file could only be found if you knew either the exact location of the directory in which it lived or the 
exact file name in order to search for it.

With tags you effectively add multiple search labels to a file and searching on one or more of the tags will 
return the file or files you are interested in.

A tag can be a single word such as 'photo', it can also consist of multiple words such as 'tax return'. To 
help reduce tag ambiguity dot notation can be used to indicate a context such as 'computers.apple' and 
'recipe.ingredient.apple', this type of tag is called a hierarchical tag.

Tip - tags consisting of multiple words must be surrounded with double 
quotes,Examples: "tax return" , "art.self portrait"

Tags are case insensitive so you can enter your tags in lower case, upper of mixed case. Taggtool will 
automatically change the case of a tag you enter if it finds that a tag already exists with a different case. 

Where are the tags stored?
All tag information is stored inside a powerful database rather than inside your files, this is done for 
technical and privacy reasons.

Certain file types such as pdf's and Microsoft Office allow metadata to be embedded into the file itself 
whilst useful also means that if you email or copy a document onto a memory stick or optical disc that 
person would be able to view your metadata with ease.

Taggtool attempts to offer the best of both worlds by keeping your tags separate from your files and 
extracting any embedded metadata it finds into it's database for searching.

What is a tag structure
Sometimes you may want to add more structure to the way you tag up files, for instance if you are sharing 
a database with another user you may want to make sure that a basic tagging structure is used so that a 
common set of tags are used rather than a complete free for all.

To facilitate this, tag structures can be designed and shared between users. 



An example tag structure 

documents documents.accounts documents.sales documents.marketing.pressrelease 

How do I create a tag structure?
Tag structures are created with the 'Tag Structures' panel in the options dialog. 

There are 2 ways to create a tag structure, the first and way is to use the Tag Structures control panel 
situated in the Options dialog. 

Using this panel, you can specify where the tag structures should be saved, by default they are saved 
under the user's documents -> tagg directory but you can change this location to be somewhere on a 
network drive if you wish to share the structures with other users. 

Tags are displayed in a tree view, so for example the tag 'documents.marketing.pressrelease' would be 
displayed as 

Documents   marketing    pressrelease 

To insert or remove a tag node click the right mouse button to display the popup menu, tag structures are 
saved automatically as you add/remove or rename tag nodes.

Tagging a File
There are 2 ways to manually add tags to a file, the first method is to use the 'Tag Files' screen in the main 
Taggtool application and the second way is to directly tag files from within the Windows file explorer.

Tagging files using the main application

Select the 'Tag Files' tab on the main screen to activate the Tagging screen. 

Navigate through the tree, selecting those files or directories you wish to tag. 

Using the built-in plugins you can preview the file before adding it, this gives you the ability to add a 
precise file title, description and tags.

To add a tag you have used before, either type the first few letters so that auto-complete pops up a menu 
of tags which match or click and drag a tag from the tag cloud to the add tags text field.

To add your own tags, simply type directly into the add tags text field, multiple tags should be comma 
delimited and multi-word tags surrounded with double quotes. 

To add the tagged file to the database, click the 'Save' button.

To select all files in a directory right click on the name of the directory to display the popup menu, from 
this menu select 'Select all'. This will select all files in the directory, it will also select files inside any 
nested directories. 



Using directory bookmarks
Directory bookmarks provide the ability to position the file system tree view to a particular directory with 
a single click, it is useful when you find yourself navigating to the same directory time and time again to 
tag files. 

To add a directory bookmark right click on any directory name, select 'Bookmark' from the popup menu. 

The next time you need to tag a file in that directory, simply select the directory from the combobox 
located above the file system tree view.

Tagging files directly from Windows file explorer

Using the Windows file explorer navigate to the file(s) you wish to tag then right click your selection to 
display the popup menu. Select 'Add Tags..' menu option to reveal the metadata panel, enter some tags 
then click on the 'save' button.

Understanding the metadata panel
The metadata panel displays all associated metadata information for any item(s) you have selected from 
either the search results panel or the tag files panel.

The metadata panel consists of 2 tab pages, namely 'Metadata' and 'Preview'.

Metadata

This tab page displays metadata you have added such as tags, descriptions, aliases and ratings as well as 
any embedded metadata extracted from the file.

You can modify the following metadata: 

Tags

Alias

Description

Rating

Assigning tags - Multiple selection behaviour 

When you select multiple tagged items the existing tags display panel will show a distinct view of all the 
tags used, for example if we had the following 2 files selected

File Tags

finances.xls money,finance,p
ersonal

insurance.pdf finance,car

The existing tags panel will display the following tags: 



car(1)+- finance(2)- money(1)+- personal(1)+- 

The numbers in the parenthesis indicate the number of times the tag is used in the selection. 

You can use the plus and minus buttons to add and remove tags currently in use, for instance to also 
assign the tag money to all of the selected items you would click the plus button next to the money tag. 

At this point the 2 files would look like this

File Tags

finances.xls money,finan
ce,personal

insurance.pdf finance,car,
money

Similarly you can use the minus symbol to remove a tag from all of the selected items. Embedded 
Metadata

To view any embedded metadata associated with a file, click on the Embedded tab. 

This will display any embedded metadata extracted from files such as

MP3 music files JPG photo's MS Office documents ADS (Alternative Data Streams - NTFS file systems 
only) 

Previewing a file
Before assigning tags to a file it is often useful to view the contents of the file, there are 2 ways to do this. 

The first way is to simply launch the file by double clicking the file name from either the search panel or 
the tag files panel, the file will be opened with the default application associated with the file type. i.e. 
Word will be launched to display .doc files. 

The second method involves the use of the plugins panel, Taggtool includes various plugins which make 
it easy to quickly preview the contents of a file without having to switch between third party applications. 

Plugins provided 

Plugin Supported Formats

Audio mp3,wav,ogg

Image bmp,jpg,gif & png

Zip zip,jar

Text txt,bat

HTML html



PDF pdf

To preview a file using the plugins, click on the 'Plugins' tab page. 

Importing files - Scan Folder
Certain file formats such as jpeg, mp3 and MS Office documents have the ability to store basic metadata 
inside the physical file. 

For example, Microsoft office documents usually contain data items such as the author of a document and 
photos saved in the jpeg format often contain data such as the make and model of a camera used to take a 
photo as well as more detailed information such as the exposure setting. 

The scan folder feature in Taggtool will search for any files which contain metadata and automatically 
import them into the active database. 

This means that you can perform searches on the imported metadata, for example if we had imported 
some MS Office documents we could search for all documents created by a specific author by using the 
following search command: 

author=jsmith 

To perform a scan of a specific folder, select the 'Scan Folder' option from the Tools menu. 

Choose the directory to scan, click ok. 

Any files which contain embedded metadata will be added to your database. 

Importing files - Scan System
The scan system is an extension to the scan folder feature, the main difference is that you can scan entire 
drives and volumes. 

To perform a system scan, select the 'Scan Folder' option from the Tools menu. 

Updating tagged items
Occasionally you will want to modify the tags attached to your files, there are 2 ways of updating your 
tagged items: 

1) From the 'Tag files' panel 2) From the 'Search' panel 

1) Making changes to files from the 'Tag Files' panel. 

The first thing to do is navigate to the file or file(s) you wish to update, use the file system tree view to 
navigate around your file system. 

Select the file(s) you wish to update (Hold down the shift key to select multiple files) 

Use the metadata panel to add/remove tags as well as change the description and rating if required. 

When you are happy with the changes, click on the save button. 



2) Making changes from the 'Search' panel 

Rather than having to navigate through the file system it is easier to perform a search for the files you 
wish to modify. 

Select the file(s) from the search results panel using the left mouse button (Shift-click to select multiple 
items. 

Make your changes in the metadata panel as described above, click the save button to complete. 

Creating a database
When you run Taggtool for the first time, a default database is created for you. 

In most cases this database is all you need however if you are going to be tagging a very large amount of 
files and like the idea of separating them into multiple databases then you can.

As an example you may want to create a photos database, a music database and a personal files database.

To create a new database select the 'Create Database' button from the toolbar. 

Enter a name for the database, some examples of valid database names: 

photos recipes college work legal documents 

If you are planning to use Taggtool Server edition then you need to make sure that the 'shared database 
checkbox' is selected. 

The checkbox ensures that only files accessable to users of the network can be tagged, this avoids the 
problem of users tagging files on their local computers which no one else can access.

Important: Once set it is not possible to switch existing tagged files from one representation to the other 
so choose carefully! 

Switching between databases
To select a different database, click the 'Select Database' button in the tool bar. 

A dialog window will be displayed containing a list of all Taggtool databases. Highlight the database you 
would like to activate then click the OK button or double click. 

Importing a Taggtool legacy xml database
Version 3 of Taggtool introduced a new method of storing tags which replaced the xml files used in 
previous versions. 

If you have a legacy database file which you would like to import then the 'Add an existing database' 
function will do just that.

To add an existing database, select the 'Add Existing Database' option in the Database tab of the 'Options' 
screen. 



Select the database you wish to add then click the ok button. 

Removing a database
If you wish to remove a database from your Taggtool environment, select the 'Remove database' button 
from the tool bar. 

Entering search criteria
To perform a search for tagged items you enter space separated search terms, for instance to find all 
tagged items related to the tag 'photo' simply type photo into the search box. 

As you type the first few letters of a tag, any matches to existing tags will be displayed in a pop-up list - if 
the list contains the tag you wish to add to your search criteria then select it from the list either with the 
mouse or by pressing the down cursor twice followed by the enter key. 

You can dismiss the suggestion box by pressing the escape key. 

Instead of typing in tags you can also select them from existing tag structures, right clicking in the search 
box will open a pop-up menu containing all tag structures which you can navigate through just like any 
other menu system. 

You can also select tags from the 'Used Tags' menu, this menu lists all tags which are in use in the current 
database organized alphabetically. 

You can enter as many search terms as you like, as well as searching the database for the specific terms 
entered Taggtool will also search against file names, file paths, file descriptions and volume names so you 
could search for all PDF files by simply typing .pdf 

To exclude a results matching a specific term you can use the minus (-) symbol, for example to search for 
photos but not holiday photos you could enter photo -holiday. 

To search for multi-word tags you must surround the search term with double quotes, i.e. "college work". 

To exclude multi-word tags, place the minus symbol before the quotes i.e. documents -"college work" 

Search Results display
Taggtool executes your searches in real-time as you type, search results are displayed in the results panel 
located below the search box. 

There are currently 3 different results views you can use: 

1. Multi View 2. Grid View 3. List View 

Multi View

By default the multi view display is used, this view categorizes your search results into 4 distinct sections 

File section Displays all files other than pictures and 



pdf's

Pictures 
section Displays images as thumbnails

PDF section Displays PDF files as thumbnails

Web section Displays website bookmarks

Grid View

The grid view displays all search hits in one big table with various columns including file 
name,path,volume and file size.

List View

The list view displays hits with minimal information in order to create a basic view. 

To switch between views, use the small view icons located towards the bottom right of the results view 
panel. 

Search Filter
Once you have entered your search criteria you can further narrow down your results by applying a search 
filter. 

Available Filters include 

• Images filter (*.bmp,*.ico,*.jpg,*.png,*.gif) 
• Audio filter (*.wav,*.mp3,*.ogg) 
• Text filter (*.txt) 
• Zip filter (*.zip,*.jar) 
• HTML filter (*.html) 
• PDF filter (*.pdf) 

To apply a filter simply expand the 'Advanced search' section by clicking on the "+" symbol and select a 
value from the filter combo box. 

Quick Search
Sometimes it's usefull to pull up a list of all pdf files or all office documents, rather than write some 
search terms to do this you can use the Quick Search panel. 

To run a quick search, expand the quick search panel by clicking on the "+" symbol next to the 'Quick 
Search' label. 

Simply click on one of the pre-defined quick searches to run.



Saving Searches
If you find yourself entering the same search criteria time and time again you can speed things up by 
saving the criteria for future use. 

To save a search, click the small disk button located next to the search filter, the save search dialog will 
appear. 

By default all searches are stored in a search folder called 'Default', to save the search enter a name for 
your search then click the ok button. 

Search Folders
You can create your own search folders by selecting the 'New Folder' menu item from the 'Saved 
Searches' menu. 

The Search folder dialog will appear, enter a name for your new folder then click the 'ok' button. 

To re-organize any existing saved searches, use the Saved Searches maintenance panel located in the 
Options dialog accessible from the main tool bar. 

Custom Applications
Often you may want to edit a file in a different application to the one associated with it by the Operating 
System. 

With Taggtool you can create custom application commands to achieve this. 

Click on the 'Settings' button in the main screen to launch the settings dialog, then select 'Custom 
Application Launcher'.

Enter a name for this command for example: Edit with Photo shop 

Locate the application executable by clicking on the 'Browse' button. 

Click 'Save'.

You can now select this Custom Application from the context menu in the search results window, you 
activate the context menu right click on a file in the search results screen. 

When you select your custom application from the menu Taggtool will launch the application with the 
selected file name appended to the end of the command.

For example if we created a custom launcher for Notepad the command executed would look like: 
Notepad.exe C:\documents\myfile.txt 

If you need more control and would like to add command line switches you can make use of the 
following in-built macros.

$File - Fully qualified path and file name i.e. C:\docs\expenses.xls $Dir - Directory to file i.e. C:\docs 

For example, to create a custom launcher which opens notepad and prints the document we could create 
the following command:



Executable command: Notepad.exe Parameters: /p $File

Synchronizing your tagged files
Select the 'Sync' menu option from the Tools menu to activate the synchronize screen. 

In most cases Taggtool will detect when a file is renamed or moved and automatically synchronise the 
database however if you are using Taggtool over a network it is possible that connectivity issues may 
cause Taggtool's database to become out of sync. If this happens you will need to use the straightforward 
'Synchronize' feature to re-align Taggtool's internal database. 

The synchronize process is made up of the following 3 steps: 

• Step 1 - Run Report to list any out of sync files 
• Step 2 - Search your computer's hard disk for possible matches 
• Step 3 - Update the database with the new file locations 

Step 1 - Run Report

The feature works by first examining the active database for any missing files, any files found to be 
missing will be listed in the Missing Files table. 

Step 2 - Search

Before execute the search, you can limit the volumes or file systems that Taggtool will search to find the 
missing file(s). 

Simply tick the checkboxes for each volume you would like Taggtool to search. 

click 'Step 2 - Search' to activate the file search.

Any matches found will be displayed in the 'Missing Files' table, if Taggtool has located possible matches 
you can proceed to the next step in order to update the database with the new file location. 

Step 3 - Resolve

The missing files table tells you which files are missing along with potential matches it has found, if there 
is more than one match for a file you can selected which match is the correct one by selecting the radio 
button in the last column. 

If you do not wish to resolve specific files listed in the missing files table, you can use the first checkbox 
column to deselect the files, this tells Taggtool to ignore these files when the Resolve button is clicked to 
update the database. 

Data Backup
Select the Backup' tab to activate the data backup screen. 

The backup feature in Taggtool provides a fast and easy way to back up all of your tagged files across all 
of your databases. 



For each database selected, Taggtool will copy the tagged files into a compressed zip file which you can 
then burn on to a CD or DVD for later recall in the event of data loss. 

To access the backup feature select the 'Backup' tab on the main screen. 

By default, Taggtool will save any backups in a directory named 'backups' under the 'Tagg' directory 
inside your user home directory. 

If you wish to change this location click the Change button, this will open a directory chooser dialog from 
which you can select a different directory. 

If you wish to view the current contents of the backup directory, click the folder button next to the change 
button, this will launch a window displaying the contents. 

The backup feature creates a compressed zip file inside this directory when the backup process is run, by 
default this file name is auto-generated and uses the following format: 

taggbackup-Day Month DayNumber HHMMSS TimeZone 4-digitYear.zip 

An example output file would be named: 

taggbackup-Thu May 24 074855 BST 2007.zip 

You can override this name by simply entering a new name into the Backup file name text field. 

If you are running multiple backups, i.e. creating a separate backup file for each database you can click 
the 'Generate' button in order to generate a new unique file name for each database you are backing up. 

The next step prior to running the backup process is to select which databases you would like to backup, 
you do this by highlighting the database name in the list box. 

After selecting which databases you are backing up, click the 'Backup' button to activate the backup 
process. 

When running you will be given realtime feedback on the backup progress via the status table as well as 
the console at the bottom of the screen. 

If you need to abort the backup, you can do so at any time by clicking the 'Stop' button. 

Automatic Database backups 
Taggtool uses a small but powerful internal database to store your tags, search folders and saved searches. 
In order to protect this data Taggtool automatically takes a copy of the internal database at regular 
intervals.

By default these copies are stored in the following directory:

C:\Users\[username]\Documents\Tagg\backups

Restoring from a backup
If the worst should happen and the internal database becomes corrupt you will be able to restore it by 
copying the contents of the backup zip file into the following directory:



C:\Users\[username]\Documents\Tagg\Database

Delicious Integration
If you use the Delicious social bookmarking service then you can configure Taggtool to integrate with it. 

With integration enabled you will be able to run searches against your website bookmarks in the same 
way that you can with files. 

You can also update your Delicious bookmarks, tags and descriptions via Taggtool. 

If you do not have a Delicious account you can open one for free at http://www.delicious.com 

Configuring Delicious Integration

Launch Taggtool's Option dialog by clicking on the 'Options' button in the toolbar. 

Select the 'Delicious' tab page towards the top of the dialog. 

Enter your Delicious user name and password in the fields provided. 

If you access the internet via a proxy server you can enter the host and port information into the fields 
labelled proxy. 

If you don't know what that means then leave these fields blank. 

Tick the 'Enable Delicious integration' checkbox. 

You now need to restart Taggtool to complete the process. 

How do I stop and start Taggtool

To stop Taggtool you need to right-click on the small tag icon in the tasktray located towards the bottom 
right of screen, select 'Exit' from the popup menu which appears. 

To start Taggtool, you can select it from the Start Menu -> All Programs -> Taggtool -> Tagg -> 
Taggtool or double click the Taggtool icon on the desktop. 

The search widget
Whenever the Taggtool application is minimized or closed a small widget will appear on your desktop 
which can be used to perform searches without having to restore the application. 

The search widget works in a similar way to the regular search panel, you simply enter your search terms 
into the text field and hit enter. The results of the search will be displayed in a panel attached to the 
widget. 



The file tagging widget
As well as performing searches from your desktop it is also possible to add tags, descriptions and ratings 
to files using Windows file explorer.

To tag up a file(s), navigate to the file you wish to tag using the file explorer then right click on the file 
and select 'Add Tags' from the pop-up menu.

A small metadata panel will appear, use this window to enter your tags as well as any other metadata such 
as aliases, descriptions and ratings. Click save to commit your changes into the current database.

Fresh Files
The fresh files panel lists any new files created on your system in real-time, for example if you create a 
Word document a new entry will appear in the fresh files list. You can then tag up this file if required.

Due to the nature of operating systems many files are created by the system and applications which you 
may not be interested in so to avoid having long lists of you can filter out certain folders and file 
extensions. 

To create a filter, select a file in the fresh files grid then right click to bring up the popup menu. From this 
menu you can choose to filter out all files by the file extension or you can choose to filter out all files by 
folder. By default, any nested folders which appear inside the selected folder will also be filtered out. 

For example: A filter applied to c:\programs\data will also include c:\programs\data\temp 

If at any time you wish to remove any filters then you can do so via the Fresh Files tab page in the 
Options dialog which is acessible from the main toolbar or main menu. 

Rules
In addition to simply displaying fresh files, you can also create rules to automatically tag these files if 
they meet certain conditions.

For example, you could create a rule to automatically tag Microsoft Office documents with 'my-office' if 
they have been created inside the 'My Documents' folder.

At a later date you could then run a search for 'my-office' and add more descriptive tags if required. 
Adding rules is a powerful way of staying organized and reduces the amount of manual tagging you 
would otherwise have to do. 

To create a new rule, click on the 'New Rule' button. In the rule dialog which appears, select which types 
of files you wish to process, i.e. *.doc for word files or *.* if you want the rule to be run against all file 
types. 

Some common file types can be selected from the combobox next to the file extension filter, these cover 
various file types such as MS Office, Sound files, Image files etc.

The next step is to select which folder you wish the rule to be applied against, you can control whether or 
not to include sub folders by placing a tick in the checkbox.

Finally you can choose whether or not to enable the rule right now or disable it for future use. 



Click 'ok' to save the rule. 

If at any time you wish to modify a rule, simply double click the rule to display the rule dialog. 

To delete a rule, click the 'delete' button. 

Recently Opened Files
The 'Recently Opened' panel lists all files opened via the Taggtool application. The purpose is to shortcut 
the traditional method of first searching for a file, then opening. If you know that you recently looked at a 
file then you can by-pass the search by looking at the recently opened file list. 

Files are listed in reverse chronological order hence the most recent file is placed at the top. 

To re-open a file, simply double click the file you require. 

What is the server edition?
The Taggtool server edition provides a way for multiple users to share and tag files in the same database 
at the same time.

The typical scenario is that you have 1 Taggtool server edition installed which multiple users can connect 
to via computers running the Taggtool Desktop Edition.

This makes it possible for multiple users to share the same database and view each others tags in realtime.

This collaborative approach to file management makes it a breeze for small teams to tag and share files on 
network shares or NAS devices.

By default databases created via the server edition are configured as 'shared' databases meaning that users 
are restricted from only tagging files and folders which all users can see i.e. Network folder shares. 

After installing and running Taggtool server edition it is necessary to make sure that any firewalls present 
are configured to allow network traffic over port 1527. 

Connecting to a Taggtool server
To connect to a Taggtool server, the server name and port number are needed. This information can be 
found by opening the About box (Help menu -> About) on the computer running Taggtool server edition. 

To connect to the server, select 'Taggtool Server' -> 'Connect to server' from the main menu. This will 
launch a connection dialog into which you will need to enter the server name and port number. 

If you want Taggtool to automatically connect to the server when it startsup then click on the reconnect 
checkbox. 

Finally, click 'ok' to connect to the server. 

If at anytime you wish to disconnect from the server, click 'Taggtool Server' -> Disconnect from the main 
menu. 

When disconnected, you are switched back to your local database. 
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